
Cellpro 10s Charger
Model LC10S10ADC, for use with LiPo, Li-Ion and A123 
battery packs with node connectors
10 Amp model for automatic and manual charging with 
cell balancing and overcharge protection

FMA, Inc.    5713 Industry Lane, Suite 50    Frederick, MD  21704

Sales: (800) 343-2934    Technical: (301) 668-4280    www.fmadirect.com

Features
	 Charges Lithium Polymer, Lithium Ion and A123 packs.  Charges any brand of pack.  Accepts 

Cellpro Adapters for plug-and-play compatibility.
	 Accepts Cellpro node connectors, which enable the charger to monitor each cell during charg-

ing and independently charge each cell to its optimum level.  Charger includes two adapters 
for charging 2s to 4s Cellpro packs having 5-pin node connectors.

	 Charges one 1s to 10s pack, or two 1s to 5s packs simultaneously.  When two packs are con-
nected to the charger, internal electronic switches connect the packs in series.

	 Up to 10A charge current (318W continuous input and 260W continuous output at 15.7V input).
	 Up to 3.0C charge rate, the fastest in the industry.
n	 Charges packs through node connectors with or without connecting main discharge wires to 

charger.  Compensates for discharge wire lengths up to six feet with 1mV accuracy.
	 Displays individual cell internal resistance to 0.1milliohm, an exclusive feature for estimating 

pack quality and finding bad cells.
	 Backlit LCD display provides easy readability.
	 Bidirectional PC interface enables extensive charger setup using free Charge Control Soft-

ware.  Configure custom presets, adjust speaker volume, set LCD contrast and control many 
other settings.

	 Charge Optimization can be set for an accurate 1mV cell balance or for Faster Charging (with 
less balance) using the Charge Control Software.

	 Charge Control Software automatically checks for software and charger firmware updates.  
Update charger firmware without sending the charger back to the factory.

	 Works with a wide range of power supplies, even those not rated for high power.  Easily 
changes from moderate current bench supply at home to car battery at the field.

	 Intelligent controller performs extensive checks to prevent damage to packs and power supply.

Precautions
	 Follow all instructions in this manual to assure safe operation.
	 IMPORTANT:  Do not disconnect or connect packs while the charger is charging.
	 Always watch LiPo packs while they are charging.  Never leave LiPo packs unsupervised dur-

ing charging.
	 See additional warning sheets provided with FMA LiPo packs.
	 Follow all guidelines for charging, discharging, handling and storing LiPo cells.
	 Minor arcing may occur when discharge wires are connected to the charger before charging.  

This is normal.
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Parts
	Cellpro 10s Charger
	2 6-pin to 5-pin node connector adapters (to enable Cellpro packs equipped with 5-pin con-

nectors to be charged using the Cellpro 10s Charger)
	Plug Blocker (to enable charging packs without connecting discharge wires)
	Optional:  FUIM2 PC connectivity set (required for using the Charge Control Software)

Charger and pack terminology

Mode button

Start/Stop button

Channel 1
node connector

Channel 2
node connector

Banana jacks for discharge wires when charging one pack, or 
insert Plug Blocker when not charging through discharge wires

Banana jacks for discharge 
wires when charging two 
packs at the same time

To power
source

Auto
mini-
fuse

Connect FUIM2 here when 
using Charge Control Software

Display Channel 1 Channel 2

Discharge wires:
Red = pack positive
Black = pack negative

Node connector
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Understanding the Cellpro 10s Charger
You can set the Cellpro 10s Charger’s charge rate to one of three Auto modes—1C, 2C or 3C—as 
appropriate for the pack(s) being charged.  When one of these rates is selected, the charger 
determines the pack’s capacity and automatically sets the correct output current using FMA’s ad-
vanced Fuel Gauging technology.  You can also manually set charge current to any value between 
0.1A and 10A in 0.1A increments.  Finally, you can select Storage Charge mode which charges 
to 50% rated capacity using Fuel Gauging technology.  The charger handles multiple chemistries 
and charge parameter presets.
When one pack is connected to the charger, the pack is intially charged at the selected charge rate 
(or the maximum charge rate possible).  Using Ohm’s law, the maximum charge rate (Amps) is 
derived from the maximum power (Watts) the charger can produce without overheating.
Maximum power is approximately 300W measured at the charger input (FMA rates maximum 
power using a 15V DC input source).  Maximum power depends on many factors including pack 
imbalance during charge, input (supply) voltage, output (charge) voltage, DC/DC converter ef-
ficiency (which varies between 80% and 90% depending on the relationship of supply voltage-to-
charge voltage), ambient temperature, and internal operating temperature.

Peak Power = Maximum input power charger draws for first 3-5 minutes of charge.

When the pack reaches about 90% capacity, the charger enters balance charge mode.  Charge cur-
rent tapers off, but will remain at 1A or higher until the pack voltage slows the current to 1/20th 
C (Constant Voltage Mode).  When the pack reaches 99% capacity, the charger beeps three times.   
The pack can be removed to use, or allowed to continue charging until the pack is 100% full and 
the charger displays “Charge Complete.”
During the entire charge process, the charger power balances the pack using 1A current until 
all cell voltages are within 1mV of each other.  Power balancing is the process of beginning the 
balancing process early in the charge cycle using high current to shunt excess cell voltage while 
other cells in the pack have a chance to catch up.  Power balancing means the pack tops off faster 
and the total charge time is greatly reduced.  This is possible because the balance circuitry is in-
ternal to the charger.  Automatic temperature control and an integral fan ensure the charger never 
exceeds maximum safe operating temperature under any conditions.  The result is faster, safer 
charge times.
When charging two packs, the packs are connected in series using four electronic switches inside 
the charger.  In effect, the charger treats the two packs as a single pack.  (For example, if you 
connect a 3s pack and a 4s pack, the charger operates on them as one 7s pack.)  If the pack ca-
pacities are different for the two packs connected, the charge rate should be selected based on the 
lower capacity pack.  Initially, the packs are charged at the selected charge rate (or the maximum 
charge rate possible) until one pack becomes fully charged—however, the charger handles cell 
balancing of the two packs completely independently.  The second pack continues to be charged 
at a minimum of 1A charge rate until it is full and balanced.
Notice that one of the packs in a simultaneously charged pair is always topped off at a minimum 
rate of 1A (dictated by the maximum balance current available).  If the packs have the same 
capacity, and were discharged to about the same level, both packs will charge in less than 30 min-
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utes at 3C.  However, if the packs have different capacities, or were discharged to different levels, 
charging for the pair could take longer than expected.  Since the charger supports fast balance cur-
rent of 1A, all other things being equal, the charger still outperforms competing brands.  In most in-
stances, by the time the first pack is fully charged, the second pack is already approaching constant 
voltage charge mode; the battery pack itself is the limiting factor in charge time, not the charger.

Example 1:  You are powering an aircraft with two 4s 2100mAh packs connected 
in series.  Because those packs have the same capacity, and were discharged to 
about the same level, you can expect them to charge in about the same time.  It 
would be appropriate to charge them simultaneously using the Cellpro 10s Charger.
Example 2:  You are powering one aircraft with a 3s 500mAh pack, and other air-
craft with a 5s 5000mAh pack.  If you charge these packs simultaneously using the 
Cellpro 10s Charger, it would probably take a long time (the 500mAh pack would 
become full first, then the charger would switch to its 1A balancing rate to fill up 
5000mAh pack, which could take several hours).  In this case, it would be faster 
to charge these packs separately because the charger can then apply optimum (and 
substantially different) charge currents to each pack.

In some cases, such as Example 2, it will be faster to charge two packs separately rather than 
simultaneously.  It’s up to you to decide whether to charge two packs individually or as a pair, 
based on what you know about their respective capacities and discharge states.
The Cellpro 10s is equipped with FMA Fuel Gauging technology.  During all phases of the 
charge process, the charger will report the fuel level of two packs being charged independently.  
In Example 2 above, when the 500 mAh pack reaches 99% capacity (the charger beeps three 
times), it is a simple matter to remove the pack from the charger and continue charging the 5000 
mAh pack at a higher charge rate.  Here’s the full procedure:
1.	 Connect both packs and start charging them at an Auto rate.
2.	 Watch the fuel level display.  When one pack reaches 99% fuel level (the charger beeps three 

times), stop charging.
3.	 Disconnect the full pack.
4.	 If the partially charged pack is connected to Channel 2, move it to Channel 1.
5.	 Continue charging the partially-charged pack.

Charger input current limiting

The charger will draw up to 25A to deliver its 10A maximum output current.  The high input current 
is required when the input voltage must be boosted to drive packs having larger numbers of cells 
in series.  The charger’s algorithms are based on power, not current.  The charger initially draws 
300W, but will automatically reduce power consumption based on its internal temperature.  Output 
power is determined by several factors, including battery pack imbalance during charge, input volt-
age, input current, output voltage, ambient temperature, and the charger’s internal temperature.
The charger’s DC-to-DC converter is typically 80% to 90% efficient.  Highest efficiency occurs 
when the input voltage is higher than the output voltage needed to charge the connected pack(s).  
However, the charger cannot tolerate input higher than 16V.  Setting the input voltage to 15V pro-
vides the highest efficiency, coolest operating temperature and fastest charging times, especially 
when charging packs containing more than five cells in series.
You can also manually limit the charger’s input current so the charger will not draw more power 
than the supply can provide.  If you know your power supply is rated for 3A output, for example, 
you can limit the charger’s input current to 3A.  (Be aware that limiting charger input current 
may increase pack charge times.)  When the charger is powered from a high current source (such 
as a car battery), you can override manual current limiting to provide maximum pack charging 
current.  Details are provided in “Limiting charger input current” in the “Using the Charge Con-
trol Software” section of this manual.
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Connecting packs to the charger
General information

	 If a pack has both a node connector and discharge wires, you can charge using the node con-
nector only, or both node connector and discharge wires.  When charging two packs simul-
taneously, both packs must be connected the same way: either node connectors only, or both 
node connectors and discharge wires.
	 When charging only through a node connector, the charger balances individual cells.  

However, charge current is limited to 4A to protect the small node connector wires.
	 When charging through both node connector and discharge wires, the charger balances 

individual cells and measures individual cell internal resistances.  Charge current is not 
limited to 4A.

	 When charging only one pack, always plug that pack into the charger’s Ch1 jack.
	 When charging only one pack using its discharge wires and node connector, always connect 

the discharge wires to the charger’s outermost banana jacks.
	 When charging one or two packs without using discharge wires, you must plug the Plug 

Blocker into the charger’s banana jacks.
	 When charging two packs, both packs must have the same chemistry.  For example, you can’t 

charge one A123 pack and one LiPo pack at the same time.
	 Pack discharge wires are usually not terminated in banana plugs (e.g., they might be termi-

nated in a Deans connector).  For convenience in connecting to the charger, prepare an adapter 
cable with banana plugs on one end and a connector that mates with the pack’s discharge 
connector on the other end.  FMA sells banana plugs suitable for this purpose as FMA Part 
Numbers BPNS-BLK (Black –) and BPNS-RED (Red +).

CAUTION:  When using the banana plug adapter cables described above, ALWAYS 
insert the banana plugs into the charger BEFORE connecting the adapter cable to the 
pack.  Reverse the sequence when disconnecting the pack.  This will prevent the live 
banana plugs from touching each other, which would create a dangerous condition and 
could seriously damage the pack.

Connecting non-Cellpro packs

Generally follow the instructions in “Connecting one 1s to 10s Cellpro pack” and “Connecting 
two 1s to 5s Cellpro packs,” but your packs may not be equipped with compatible node connec-
tors.  FMA Direct offers plug-and-play adapters for charging LiPo packs equipped with node 
connectors made by other vendors.  Check www.fmadirect.com/cellpro_adapters.html for adapter 
compatibility.  The Cellpro 10s charger works with all existing Cellpro 4s charger adapters.  You 
must connect a 6 pin-to-5 pin Adapter (provided with the Cellpro 10s Charger) between the char-
ger and the Cellpro 4s charger adapter, as shown here:

Cellpro 4s
ChargerAdapter

Non-Cellpro 
pack

6-pin to 5-pin
Adapter

Cellpro 10s
Charger

If an adapter isn’t available for the pack you want to charge, or if the pack doesn’t have a node 
connector, the FMA Part Number CPBP7 (Cellpro battery pigtail 10”, 5 position) and/or FMA 
Part Number CPBP6P-10 (Cellpro battery pigtail 10”, 6 position) cable assemblies can be used to 
make the pack compatible with the Cellpro 10s Charger.  Instructions for connecting these cable 
assemblies to your packs are provided in the “Cellpro Pin Lead Connection” document at 	
www.fmadirect/support_docs/item_1254.pdf.  See also “Node connector wiring,” later in this 
manual.
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Connecting one 1s to 10s Cellpro pack

1.	 How you connect the Cellpro pack’s node connector(s) to the charger depends on the pack’s 
configuration.  Find the pack’s configuration in the diagrams below, then connect as shown in 
that diagram.

2.	 If you are using the discharge wires during charging the single pack, plug the discharge wires 
into the outermost banana jacks.

	 	 or
	 If you are not using the discharge wires during charging, insert the Plug Blocker into the out-

ermost banana jacks.

6-pin to 5-pin
Adapter

1s to 4s
Cellpro pack

Ch2

Ch1

5s
Cellpro pack

Ch2

Ch1

6-pin to 5-pin
Adapter

6s to 9s
Cellpro pack

Pack positive and
higher-numbered nodes

Pack negative and
lower-numbered nodes

Ch2

Ch1

10s
Cellpro pack

Pack positive and
higher-numbered nodes

Pack negative and
lower-numbered nodes

Ch2

Ch1

+–

1 2

From single pack connected to Ch1
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Connecting two 1s to 5s Cellpro packs

1.	 How you connect the Cellpro packs’ node connectors to the charger depends on the packs’ 
configurations.  Find the configurations in the diagrams below, then connect as shown in that 
diagram.

2.	 If you are using the discharge wires during charging, connect the discharge wires into the ba-
nana jacks as shown below.

	 	 or
	 If you are not using the discharge wires during charging, insert the Plug Blocker into the out-

ermost banana jacks.

Ch2

Ch1
6-pin to 5-pin

Adapter
1s to 4s

Cellpro pack

6-pin to 5-pin
Adapter

1s to 4s
Cellpro pack

Ch2

Ch1
5s

Cellpro pack

6-pin to 5-pin
Adapter

1s to 4s
Cellpro pack

Ch2

Ch1

5s
Cellpro pack

6-pin to 5-pin
Adapter

1s to 4s
Cellpro pack

Ch2

Ch1

5s
Cellpro pack

5s
Cellpro pack

+ –– +
From Ch1 pack From Ch2 pack

1 2
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Applying power to the charger
	 To apply power to the charger:  Connect the charger to a 12V to 15V bench power supply, 

field battery or car battery.  If your bench power supply is equipped with banana jacks for 
output, you can remove the plier clamps from the charger’s input cables and plug the cables 
directly into the power supply jacks.

When the charger is powered up, it displays the following screens in sequence:

FMA Cellpro 10s
[firmware version]*

2 Packs Charge
[chem]* Set @ [charge current]*

SAFE TO CONNECT
[optimization method]*

*Information in square brackets varies.

Here’s a quick summary of what you can do from the Home screen:
n	 Press the Start/Stop button quickly to change the optimization method.
n	 Press the Mode button to select a preset.  Press and hold the Mode button to change a preset’s 

chemistry or charge current.
n	 Press and hold the Start/Stop button for at least one second to begin charging.  During charg-

ing:
l	 Press the Mode button repeatedly to view charge data.
l	 Press and hold the Start/Stop button for one second to stop charging.

Detailed operating instructions are in “Operating the charger.”

Introduction to presets

As shipped from the factory, the charger has two presets:
	 2 Packs Charge, LiPo Set @ 1.0C
	 1 Pack Charge, LiPo Set @ 1.0C
When power is applied, the charger always initializes to the last preset used for charging.  In-
structions in “Selecting a preset,” on the next page, show how to switch between these presets.
If you altered the charge settings for a preset at the charger (as described in “Changing a preset,” 
on the next page), those changes are retained when the charger is disconnected from power, and 
will be reapplied when the charger is powered up again.

Note:  If you programmed the charger using the Charge Control Software, additional 
presets may be available.  Also, if you have been using the software, you may have 
given the factory presets different names.  Bottom line: if you change settings at the 
charger, or redefine presets, you probably won’t see the factory presets shown above.

Welcome screen

Last-used preset

Home screen
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Operating the charger
You operate the charger using the Mode button and Start/Stop button:
	 Mode button:  enables you to select a preset, change preset values and—during charging—

display charging data.
	 Start/Stop button:  enables you to select an optimization method, start charging, and stop 

charging.
This section provides detailed instructions for all these operations.

Selecting the optimization method

Press the Start button quickly to select the desired optimization method:
n	 ACCURATE CHARGE :  charging stops when all cells are at exactly the target voltage.
n	 FASTER CHARGE :  charging stops when the pack draws less than 10% of the set charge 

current, regardless of individual cell voltages.  Since balancing begins early in the charge 
cycle, significant balancing still takes place.

Selecting a preset

	 To determine the currently selected preset and review its settings:  Press the Mode button on 
the charger’s right side.

	 To select a different preset:  Press the Mode button until you see the desired preset’s name 
and settings in the display, then wait until you see the SAFE TO CONNECT screen.

The preset displayed when you stop pressing the Mode button is the “selected” preset.  Once the 
preset is selected, you can change the charge settings for this preset (see “Changing a preset”) or 
begin charging by pressing the Start/Stop button.

Note:  The Charge Control Software enables you define up to six custom presets.  If 
you have defined custom presets, you can—at the charger—select any preset.  (If you 
have not defined custom presets, the two factory presets are available.)

Changing a preset

You can change the charge settings for the currently selected preset to match the characteristics of 
the pack(s) you are charging.

Note:  Changes you make to presets are saved in the charger when the charger is dis-
connected from power.

1.	 Select the preset you want to change (see “Selecting a preset,” above).
2.	 At this point, there are several things you can do:
	 To change the chemistry:

a.	 Press and hold the Mode button, then release it when the display changes to this:

Choose Chemistry
Hold for More

Note:  If you hold the Mode button down longer, you’ll see Choose Chg. Amps 
or Exit (both described below).

	 When you release the Mode button, you’ll see the chemistry setting:

Choose Chemistry
[chemistry] @[voltage]
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b.	 Press and release the Mode button until you see the chemistry you want.  Choices are:
	 Lithium Poly 4.20V
	 Lithium Ion 4.20V
	 Lithium Ion 4.10V
	 A123 3.65V

	 To change the charge current:
a.	 Press and hold the Mode button, then release it when the display changes to this:

Choose Chg. Amps
Hold for More

Note:  If you hold the Mode button down longer, you’ll see Exit (described below) 
or Choose Chemistry (described above).

	 When you release the Mode button, you’ll see the charge current setting:

Choose Chg. Amps
Charge @ [current]

b.	 Then:

	 Press the Mode button about once per second to increase current in 0.1A steps.

	 Press the Mode button quickly twice to increase current to the next Amp.

	 When the maximum current is reached, press the Mode button once for each of the 
following three Auto charge modes or Storage charge mode:
	 1.0C (where C = pack’s capacity)
	 2.0C
	 3.0C
	 Store (to charge pack to about 50% capacity; optimum for long-term 

storage)
	 (Return to charge current settings at 0.1A)

Note:  The charger’s Auto charge fuel gauge tables are optimized for Lithium Cobalt 
batteries.  If you are charging Lithium Manganese batteries, Auto charge modes may 
take twice as long as expected.  Manual current settings are recommended when charg-
ing Lithium Manganese batteries.

	 To save the settings and return to the Home screen:  Press and hold the Mode button, then 
release it when the display changes to this:

Exit
Hold for More

Note:  If you hold the Mode button down longer, you’ll see Choose Chemistry 
or Choose Chg. Amps (both described above).

	 	 	 or
	 To save the settings and begin charging if a pack is connected to the charger:  Press the 

Start/Stop button on the charger’s right side.  Details are provided in the next section.
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Charging a pack or packs

1.	 Before charging, pack(s) must be properly connected to the charger.  See “Connecting packs 
to the charger,” earlier in this manual, for details.

2.	 Press the Start/Stop button for one second to enter Charging Mode.
3.	 You will see the following screens in sequence:

Checking Pack(s)

CHARGING   Press
MODE for info.

4.	 While in Charge Mode, you can take the following actions:
	 To view pack and operating data:  Press the Mode button repeatedly to cycle through the 

following screens.  (These examples assume two packs are being charged; if one pack is 
being charged, only the top line may appear in some screens.)

C 0.5A 00:00:59
Supply=13.8V/ 1A

[preset name]
[chem] Set @ [charge current]

Ch1 [chemistry] [charge process]
Ch2 [chemistry] [charge process]

Ch1 Fuel = 47%
Ch2 Fuel = 55%

Ch1 Pack = 11.754V
Ch2 Pack = 11.821V

Ch1    42mAh In
Ch2    40mAh In

1:3.835V 2:3.955V
3=3.959V 4=3.873V

1:23.3mΩ  2:17.1
3=12.1mΩ  4=25.7

*Cells are numbered from 1 through n, where 1 is the first cell in the pack connected to Ch1, and n is the 
last cell in the pack (if only one pack is being charged) or the last cell in the pack connected to Ch2 (if two 
packs are being charged).

†For the charger to calculate internal resistances, a) pack discharge wires must be connected during 
charging and b) pack must be at less than 80% fuel level.  Internal resistances will be available for display 
after about 12 minutes of charging, and will be periodically updated after that.

Selected preset.

Preset’s charging settings.

Chemistry and charge process 
(Fast Charging, Balance Charg-
ing, etc.) in effect for each 
channel.
Results of unique FMA algorithm 
that determines pack “fuel level.”  
Data is also used to calculate cor-
rect C rate during 1/2/3C charging.

Total pack voltage(s).

mAh put back into pack(s) dur-
ing charging.

Individual cell voltages.*  “:” indicates 
Ch1, “=” indicates Ch2.  Similar screens 
may appear, depending on the number 
of cells being charged.

Individual cell internal resistances in 
milliohms.*†  “:” indicates Ch1, “=” 
indicates Ch2.  Similar screens may 
appear, depending on the number of 
cells being charged.

Charge current and charge time.

Supply voltage and input current.
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	 To stop charging:  Press the Start/Stop button for one second.  The charger displays the 
Home screen.

Note:  Pack data is lost when you leave Charging Mode, so if you want to see it, do so 
before pressing the Start/Stop button.

Note:  If you restart the charge, you might see a Please wait... screen.  The 
charger is discharging capacitors, which may take up to one minute.  When reinitializa-
tion is complete, charging will begin again.

5.	 When charging is complete, the display below will appear, and the charger will beep for about 
30 seconds to alert you.

Ch1 [chemistry] DONE
Ch2 [chemistry] DONE

	 To review final data for the pack(s):  Press the Mode button to cycle through the data 
screens.

Note:  Pack data is lost when you leave Charging Mode, so if you want to see it, do so 
before pressing the Start/Stop button.

	 To leave Charging Mode:  Press the Start/Stop button.

Alternate charging modes

Based on what the charger determines about charging conditions, it may enter one of these charg-
ing modes (as indicated in the display):
	 In Low Voltage Restore Mode, the charger automatically attempts to repair an overdischarged 

pack.  Cells discharged as low as 0.5V may be repaired to as much as 98% of capacity.
	 In Safety Charging Mode, the charger detects that at least one cell is seriously out of bal-

ance, and automatically lowers charge current to 0.5A.
CAUTION:  If the charger’s display shows SAFETY CHARGING during several 
attempts at charging, the pack is damaged.  Treat damaged packs with caution.  Do not 
charge them on a flammable surface, and do not charge them unattended.

	 In Cold Weather Balancing Mode, charging automatically stops at 4.10V/cell when tem-
perature is below 55°F to prevent cell damage.

If the charger detects a problem, it will stop charging and display a safety code.  If this happens:
1.	 Press the Mode button to reset the charger.
2.	 Reconnect the battery properly.
3.	 Press the Start/Stop button to continue charging.
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Using the Charge Control Software
The Cellpro 10s Charge Control Software enables you to define presets, save and load groups of 
presets, update the charger’s firmware, and control various aspects of the charger’s options.

Installing the Charge Control Software

1.	 On your Windows-based computer, launch Internet Explorer and navigate to
	 	 http://www.fmadirect.com/new_applications/CellPro10S_Software/setup.exe
2.	 Follow the instructions displayed onscreen.  The software will download, install and launch.

*If you encounter a problem because your default browser is not Internet Explorer, temporarily designate Internet Ex-
plorer as your default browser:
1.	 Start > Control Panel.
2.	 In the Control Panel, double-click Add or Remove Programs.
3.	 In the Add or Remove Programs dialog, click Set Program Access and Defaults in the left panel.
4.	 Open the Custom panel.
5.	 Under Choose a default Web browser, click Internet Explorer.
6.	 Click OK.
7.	 Close the Add or Remove Programs dialog and the Control Panel dialog.
After installing the Charge Control Software, you can revert back to your preferred browser.

Launching the Charge Control Software

1.	 Start > All Programs > FMA Direct > Cellpro 10s.
2.	 If your computer is connected to the Internet at this time, the program will check to see 

whether a new version is available.  If a new version is available, you will have the option to 
install the new version or launch the version you already have.

3.	 After the program launches, and if your computer is connected to the Internet, the program 
will check to see whether a new version of the charger firmware is available.  If new firmware 
is available, a message will appear; click OK to close the message window.  See “Updating 
charger firmware,” later in this manual, for instructions.

Connecting the charger to your computer

1.	 Plug the FUIM2’s 3-pin connector into the jack on the charger’s left side.  The black wire 
should be toward the bottom of the charger’s panel.

2.	 Plug the FUIM2’s USB connector into your computer.
3.	 If the Charge Control Software isn’t running, launch it now.
4.	 Watch the message line just below the program’s menu bar.
	 If “Waiting to Start” appears, everything is working properly and you are ready to use the 

program.
	 If “Checking Com COMx for data” doesn’t go away, the program can’t communicate with 

the charger.  To correct this:
a.	 Click Download USB Driver at the bottom the  Charge Control Software window.
b.	 Run the installer.
c.	 Restart your computer.
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Monitoring charging operations

	 To monitor cell voltages, total pack voltage and related charging parameters during charg-
ing:  Click the Cells tab.

	 To monitor cell internal resistances during charging:  Click the Int. Res. tab.

Note:  For the charger to calculate internal resistances, a) pack discharge wires must 
be connected during charging and b) pack must be at less than 80% fuel level.  Internal 
resistances will be available for display after about 12 minutes of charging, and will be 
periodically updated after that.

	 To view cell parameter graphs:  View > Graphs.  In the Graphs window:
	 To view volts:  View > Volts.
	 To view current:  View > Amps.
	 To view internal resistance:  View > Internal Resistance.
	 To view fuel level:  View > Fuel.
	 To print a graph:  File > Print.

Limiting charger input current

The charger will draw up to 25A to deliver its 10A maximum output current.  The high input 
current is required when the input voltage must be boosted to drive packs having larger numbers 
of cells in series.  The charger monitors input current from the power supply, and automatically 
reduces pack charge current if it determines that the power supply can’t keep up.
You can also manually limit the charger’s input current so the charger will not draw more power 
than the supply can provide.  If you know your power supply is rated for 3A output, for example, 
you can limit the charger’s input current to 3A.  This feature prevents damage to power supplies, 
such as bench supplies, having low to moderate output currents.  (Be aware that limiting charger 
input current may increase pack charge times.)  When the charger is powered from a high current 
source (such as a car battery), you can override manual current limiting to provide maximum 
pack charging current.
	 To monitor supply voltage:  Click the Supply tab.
	 To manually set input current limiting:  

1.	 In the Supply tab, select the desired maximum current in the Current Limit dropdown 
list.

2.	 Click the Update Charger button.
	 To override manual input current limiting at the field without using the Charge Control Soft-

ware:
1.	 Press and hold the charger’s Mode button.
2.	 Connect the charger’s input cables to the power source.
3.	 When you see characters in the charger’s LCD display, release the Mode button.

Note:  If manual input current limiting is in effect, you must repeat this procedure each 
time you apply power to the charger if you want the charger to operate at full input cur-
rent.
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Defining presets

You can define up to six preset charging configurations.  Each preset consists of a name, a chem-
istry and a charge current.  See “Selecting a preset,” earlier in this manual, for instructions on 
selecting a preset for charging.

Note:  Remember that presets can be overridden at the charger.  Preset changes made 
at the charger are retained in the charger until manually changed again, or until a new 
group of presets is downloaded to the charger.  When you connect the charger to the 
computer and launch the Charge Control Software, the program uploads and displays 
the presets stored in the charger.

Perform all preset operations in the Presets tab.
	 To define a preset:

1.	 In the Name field, enter a name for the preset.
2.	 In the Chem field, select the chemistry.
3.	 In the Amps field, select the charge current.
4.	 If this preset will be used to charge a 6s to 10s pack, activate the Single Pack option (this 

enables the charger to treat Ch1 and Ch2 as a single channel).
	 To download presets to the charger:  Click Update Charger.  The charger will beep when 

downloading is complete.	
	 or	
To ignore changes and restore the previous presets:  Click Cancel.

	 To restore the factory settings:  Click Factory Default, then click Update Charger.
Note:  This restores the factory default presets, and also resets the LCD contrast, 
speaker settings and auto scroll settings.

Setting charger options

1.	 Click the Options tab.
2.	 Set options as desired:
	 LCD Contrast sets the contrast of the charger’s LCD display.  The display will be easier 

to read in bright conditions when the contrast is high.
	 Auto Scroll Cells ON option, when activated, directs the charger to scroll through screens 

during charging.  Auto Scroll Seconds controls how long each screen is displayed.
	 Speaker Volume controls the loudness of the charger’s speaker.  If you want the charger 

to confirm when you press the Mode button and Start/Stop button, activate the Button 
Clicks ON option.  Deactivate the Speaker ON option to mute the charger.

n	 Optimize for Accuracy balances cells to 1mV.  The charger can take an additional two to 
five minutes to balance the cells.  Optimize for Fast Charge ends the charge at 0.1C.

3.	 Click Update Charger.	
	 or	
If you don’t want to apply the changes, click Cancel.
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Recording charge data

The Charge Control Software can record charge data for each charging session. 
1.	 Press the Start/Stop button on the charger to start a session.
2.	 When prompted, enter a file name.  You can enter a file name you previously used, but you 

must confirm that you want to overwrite older data.
Charge data is stored in a semicolon-delimited format, which can be imported into a spreadsheet 
for analysis.

Updating charger firmware

The Charge Control Software automatically checks for new firmware each time it is launched (as-
suming the computer is connected to the Internet).  If new firmware is available, it is downloaded 
to your computer.  When you are ready to update the charger:
1.	 Be sure the charger is connected to the computer, and is powered up.
2.	 Disconnect all packs from the charger.
3.	 In the Charge Control Software window, switch to the Firmware tab.
4.	 Select the firmware you want to download.
5.	 If the previous firmware download was interrupted, activate the My Charger is Dead option.
6.	 Click Update Firmware.
7.	 Wait—and do nothing—until updating is complete.

IMPORTANT:  During firmware downloading, do not disconnect the charger from power, 
do not disconnect the charger from the computer, and do not exit the Charge Control 
Software.

Node connector wiring
This diagram shows how a 6 pin node connector is wired to a 5s pack.

Pin 1

Red

Black

Pack positive
Node 4

Node 2
Node 3

Node 1
Pack negative

Cell 4
+
–

Cell 3
+
–

Pack negative 
(blk), 0V

Node 3, 11.1V*

Node 4, 14.8V*
Cell 5

+
–

Pack positive 
(red), 18.5V*

Cell 2
+
–

Node 2, 7.4V*

5s Pack

Cell 1
+
–

Node 1, 3.7V*

* Nominal voltage with 
respect to pack negative.
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Estimating performance factors

If you don’t have a way to directly measure your propulsion system’s electrical parameters, the 
Cellpro 10s Charger enables you to estimate them using before- and after-flight measurements.

Collect data

Charge pack.
	 
When charging is finished, record Fuel % and total pack voltage (i.e. sum of cell voltages).
	 
Fly plane (or test on the ground).  Record flight time in minutes.
	 
Connect pack to charger.  Record Fuel % and total pack voltage.

Calculate performance factors

(Fuel % before flight) – (Fuel % after flight)
100

x (Pack capacity, Ah) = Capacity consumed during flight, Ah

(Capacity consumed during flight, Ah) x 60
(Flight time, minutes) = Average current during flight, A

(Pack voltage before flight, V) + (Pack voltage after flight, V)
2 = Average voltage during flight, V

(Average voltage during flight, A) x (Average current during flight, V) = Average power during flight, Watts

Evaluate results

n	 Average current during flight gives you a rough idea whether system components—ESC, 
motor, connectors and wiring—are operating within their current ratings.  Keep in mind that 
peak current during flight may greatly exceed the average current you calculated.

n	 Watts per pound is an approximate indicator of aircraft performance (other factors influenc-
ing performance include lift, drag and motor type).  Here are some guidelines:
l	 25 to 30 watts per pound:  level flight.
l	 40 to 50 watts per pound:  take off from smooth surface, climb.
l	 50 to 75 watts per pound:  take off from grass, sport aerobatics.
l	 75 to 125 watts per pound:  pattern aerobatics.
l	 Over 125 watts per pound:  3D.

Tip:  For more direct electrical measurements, consider these FMA products:
n	 60A Current Shunt (Model DVM-SHUNT-60)
n	 Digital Multimeter (Model DVM-VC890D)

(Average power during flight, Watts)
(Model weight, pounds) = Watts per pound
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Troubleshooting
There are 26 ways to improperly connect two packs to a charger!  After the Start/Stop button is 
pressed, a special battery checking sequence automatically checks every wire before closing the 
internal switches (if discharge wires are not used during charging).  It is possible to get an unre-
lated safety code from a simple wiring issue.
Operating errors appear as messages in the display.  To determine the problem, look up the de-
scription below.  Correct the error.  If errors continue, contact FMA Customer Service.

Message	 Problem
2 Pack Con. Err	 Check pack wiring
Amps too low	 Reset the charger
Bad EEPROM Write	 Internal error
Bad FET supply voltage	 Check the input voltage
Bad Mode Number	 Internal error
Bypass Overvolt	 Check the pack wiring
C2 Pack Detected	 Pack was added to Ch2 while charging
Cell < 0.1V	 Low cell voltage
Ch1 Bad S. Count	 Cell count cannot be determined; check for a cell < 0.5V
Ch1 has no Pack	 Pack must be installed on Ch1
Ch1 No Add Up	 Cell verification failed
Ch1 Pos < 0.5V	 Check node wiring
Ch2 Bad S. Count	 Cell count cannot be determined; check for a cell < 0.5V
Ch2 No Add Up	 Cell verification failed
Charger Overcurrent	 Make sure the charger current is steady
Check Pos. Term	 Positive terminal not connected
Chg. Overvoltage	 Cell is over voltage
Chgr Temp. >160F	 Make sure the fan is working
Low Voltage Cell	 Cell did not recover after 5 minutes of charge
Neg. Term. < 0V	 Black banana jack is reading below 0 volts
No Plug Blocker	 Plug Blocker required, but not installed
Node 10 < 0V	 Last node wire is reading negative voltage
Reverse Polarity	 Check wiring
Series Chrgrs?	 Check that two chargers aren’t charging a series pack
Supply <10 Volts	 Low input supply voltage
Supply >16 Volts	 High input supply voltage
Supply Unstable	 Possible thin supply wires; set input current limiting with Charge Control 

Software
System Softstart	 Check for good power supply leads
Temp out of Rnge	 Make sure the fan is working
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Pack wiring issues can cause nuisance safety codes.  If any of the safety codes below appear, try 
connecting the pack to the banana jacks and node connectors without using the plug blocker.

Safety code	 Problem
60-65	 Positive switch close failure
66-71	 Series switch close failure
72-77	 Negative switch close failure
78	 Greater than 42V detected
79-80	 Cell count out of range (internal software check)
81-86	 Charge switch close failure
87	 Voltage steady timeout
88	 Check Pack 1 voltage out of range
89	 Check Pack 2 voltage out of range
90-92	 Internal software check
93	 Calibration checksum error.  Charger must be returned to factory for calibration.

Specifications
For battery type	 Lithium Polymer, Lithium Ion, Lithium Manganese and A123 packs; 

charger can be used with 1s to 10s packs having node connectors and 
connected to charger with an appropriate FMA adapter cable

Pack capacity	 100mAh to 65Ah (charge time limited to maximum of 12 hours)
Input voltage	 10 to 16VDC, reverse polarity protected
Input current	 Up to 25A; can be limited to 1A to 25A in 0.25A increments
Power conversion	 62.5kHz switcher operating at 90% efficiency
Nominal output voltage	 3.60, 4.10 and 4.20 volts per cell; 42V maximum
Output current	 Up to 3A, reverse polarity protected
Cell balancing	 To within 1mV with 0.1mV resolution
Voltage calibration	 Cell voltage measurements are factory calibrated to 1ppm (50μV) 

traceable to NIST
Internal switches	 Four internal FET switches series-connect packs to enable charge 

through node connectors only; switches close only after proper pack 
connection is verified; maximum switch current limited to 4A

Plug blocker	 Prevents reverse polarity connection to banana jacks after internal 
switches are closed; charger looks for 4.7kohm resistor when using 
internal switches

Current calibration	 Charge current is factory calibrated on a 4A standard; calibration is to 
±5mA

Measurement accuracy	 Absolute voltage accuracy:  ±2mV from 0 to 50V 
Charge current:  ±1% 
Capacity added to pack:  ±1% 
Percent capacity (“Fuel”):  ±5%

Internal resistance	 0.1mV voltage resolution allows accurate four point internal resistance 
measurement of each cell

Serial data output	 19.2kbps, 8 bits, 1 start bit, 1 stop bit, no parity; CRC16 checksum
Firmware updates	 Encrypted at factory, decrypted in charger
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080425

FMA limited warranty
FMA, Inc. warrants this product to be free of manufacturing defects for the term of one year from the date of pur-
chase.  Should any defects covered by this warranty occur, the product shall be repaired or replaced with a unit of 
equal performance by FMA or an authorized FMA service station.

Limits and exclusions
This warranty may be enforced only by the original purchaser, who uses this product in its original condition as 
purchased, in strict accordance with the product’s instructions.  Units returned for warranty service to an FMA 
service center will be accepted for service when shipped postpaid, with a copy of the original sales receipt or war-
ranty registration form, to the service station designated by FMA.

This warranty does not apply to:
	 Consequential or incidental losses resulting from the use of this product.
	 Damage resulting from accident, misuse, abuse, neglect, electrical surges, reversed polarity on connectors, 

lightning or other acts of God.
	 Damage from failure to follow instructions supplied with the product.
	 Damage occurring during shipment of the product either to the customer or from the customer for service 

(claims must be presented to the carrier).
	 Damage resulting from repair, adjustment, or any alteration of the product by anyone other than an authorized 

FMA technician.
	 Installation or removal charges, or damage caused by improper installation or removal.

Call (301) 668-4280 for more information about service and warranty repairs.

Quick start for the Cellpro 10s Charger

Refer to manual for complete operating details.

A.	Connect charger to a 12V to 16V (maximum) power source.
B.	 Connect pack(s) to charger.
n	 Plug pack’s node connector(s) into channel jack(s) on right side of the charger (use node 

connector adapters as needed).
n	 When charging only one pack, plug pack’s node connector into Ch1.  Plug pack’s dis-

charge wires into outermost banana jacks on charger’s panel.
n	 When charging two packs:  Plug discharge wires from Ch1 pack into banana jack pair #1, 

and plug discharge wires from Ch2 pack into banana jack pair #2. 
n	 If you choose not to charge through pack’s discharge wires, insert Plug Blocker into outer-

most banana jacks.
C.	 Configure charger:
n	 To review selected preset’s settings:  Press Mode button.
n	 To select a different preset:  Press Mode button until you see the desired preset’s name and 

settings in display.
n	 To change selected preset’s settings:  Press and hold Mode button to set chemistry and/or 

charge current.  Press and hold to exit.
D.	Press Start/Stop button for one second to begin charging.
E.	 During charging:
n	 To view charge data:  Press Mode button repeatedly.
n	 To stop charging:  Press Start/Stop button for one second.

F.	 The charger will automatically stop charging, and beep for 30 seconds, when charging is com-
plete.


